|
INSTALLATION GUIDE

SCXI"-1305 AC/DC Coupling
BNC Terminal Block

This guide describes how to install and use the SCXI-1305 AC/DC
coupling BNC terminal block.

The SCXI-1305 is a shielded terminal block with BNC and SMB
connectors that you can connect to the SCXI-1120/D, SCXI-1121,
SCXI-1125, SCXI-1126, SCXI-1140, or SCXI-1141/1142/1143 input
connectors. You can configure each SCXI-1305 channel to AC- or
DC-couple a signal to an SCXI module. Each channel can
ground-reference a floating signal with a bias resistor.

The terminal block has eight BNC and one SMB connector for easy
connection. The eight BNCs are for signal connections to the eight module
inputs. The SMB provides access to module digital signals, HOLDTRIG
for the SCXI-1140, and OUTCLK and EXTCLK for the
SCXI-1141/1142/1143. These signals are not active on the SCXI-1120/D,
SCXI-1121, SCXI-1125, and SCXI-1126.

A Caution The SCXI-1305 limits the maximum common-mode voltage of the
SCXI-1120/D, SCXI-1121, SCXI-1125, and SCXI-1126 to 42 V; or DC. Exceeding this
level may cause injury. National Instruments is not liable for damage or injuries resulting
from improper connection.

What You Need to Get Started

To set up and use the SCXI-1305 terminal block, you need the following:

U Hardware
—  SCXI-1305 terminal block
—  SCXI or PXI/SCXI combination chassis
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—  One of the following modules:
e SCXI-1120/D

e SCXI-1121

e SCXI-1125

e SCXI-1126

e SCXI-1140

e SCXI-1141/1142/1143
— BNC cable

—  SMB cable if using an SCXI-1140 or SCXI-1141/1142/1143

U Tools
—  Number 1 and 2 Phillips-head screwdrivers
— 1/8 in. flathead screwdriver
— Long-nose pliers
—  Wire cutter

—  Wire insulation stripper

U Documentation

—  SCXI-1305 AC/DC Coupling BNC Terminal Block Installation
Guide

—  Read Me First: Safety and Radio-Frequency Interference

—  DAQ Getting Started Guide

—  SCXI Quick Start Guide

—  User manual for the module used

—  SCXI chassis or PXI/SCXI combination chassis user manual

—  Technical Support Information

You can download needed documents from ni . com/manuals.

Conventions

The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

@ This icon denotes a note, which alerts you to important information.
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A
A\

italic

monospace

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on a
product, refer to the Read Me First: Safety and Radio-Frequency
Interference for information about precautions to take.

When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.

When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

Configuring Floating or Ground-Referenced Signals

Before installing and using the terminal block, you must determine what
type of signal sources are in the SCXI system. Signal sources are either
floating or ground-referenced.

A floating source is not connected in any way to the building ground
system and has an isolated ground-reference point that you cannot assume
is at the same potential as any other ground. Examples of floating sources
include transformers, insulated thermocouples, optical isolators, isolation
amplifiers, and battery-powered devices.

A ground-referenced source is connected to the building ground and shares
a common ground with the DAQ device, assuming the computer is
connected to the building power supply. Examples of ground-referenced
signals are the nonisolated outputs of any device that plugs into the building
power supply, such as signal generators and power supplies. Isolated
outputs do not constitute ground-referenced sources and are treated as
floating sources.

Reference an input signal to ground at only one point. Do not reference the
input of a differential amplifier module to ground if the signal source is
already ground-referenced. If you are measuring a floating source,
reference the input to ground.
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To ground-reference a floating signal for each channel, use the switch
settings shown in Table 1. Each channel has one switch with two positions
as follows:

*  Use the F position with floating signal sources. Setting one of these
switches to the F position connects a 100 kQ resistor between the
negative input for the channel and analog ground. This resistor
supplies the necessary reference to ground for the channel. Do not use
this position with the SCXI-1120/D, SCXI-1121, SCXI-1125, or
SCXI-1126.

*  Use the G position with ground-referenced sources. Setting the switch
to the G position disconnects the resistor from the signal path. Always
use this position on the SCXI-1120/D, SCXI-1121, SCXI-1125, and
SCXI-1126.

Table 1. Floating and Ground-Referenced Signal Configuration

Switch Position Description

References floating signals to
ground.

Disconnects ground-reference
resistor; use for signals that are
already ground-referenced
(factory setting). This is the
SCXI-1120/D, SCXI-1121,
SCXI-1125, and SCXI-1126
position.

Refer to Figure 2 for the floating and ground-referenced signal
configuration switch locations.
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Configuring the Channels for AC or DC Coupling

You can configure each channel for either AC or DC coupling using the
switch settings shown in Table 2. Change any switch settings before you
connect signals to the terminal block. Each channel requires setting two
switches in the same position for the coupling circuitry to operate properly.
Configure the channels as follows:

*  For AC coupling, set both switches to the AC position. The AC
position places single-pole highpass filters in the paths of both the
positive and negative inputs for the channel. Each filter consists of a
1 uF DC blocking capacitor and a 1 MQ resistor to analog ground!,
giving a -3 dB cutoff frequency of 0.16 Hz. The capacitors can block
up to 50 VDC; however, voltages applied to the terminal block must
not exceed +42 VDC.

*  For DC coupling, set both switches to the DC position. DC coupling
removes the filters from the signal paths and connects the BNCs
directly to the module inputs. Always use this position on the
SCXI-1121 excitation channels.

Table 2. AC/DC Coupling Configuration

Switch Position Description

Use for AC coupling of the input
signal.

Use for DC coupling of the input

AC signal (factory setting). Use this
position for the SCXI-1121
ﬂ excitation channels.
DC

Refer to Figure 2 for the AC/DC coupling configuration switch locations.

' For the SCXI-1120/D, SCXI-1121, SCXI-1125, and SCXI-1126, there is an effective 2 MQ resistor instead of two 1 MQ
resistors. This 2 MQ resistor is referenced to the negative input of the SCXI-1120/D, SCXI-1121, SCXI-1125, and SCXI-1126
instead of ground to maintain the SCXI-1120/D, SCXI-1121, SCXI-1125, and SCXI-1126 isolation.
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Configuring the Clock

Due to space limitations, a jumper, W1, inside the terminal block is used to
select the clock that goes to the SMB connector. Figure 2 shows the
location of jumper W1. Refer to the SCXI-1140 User Manual or
SCXI-1141/1142/1143 User Manual for the use of these clocks.

Connecting the Signals

@ Note Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting or disconnecting any signal wires.

To connect the signal to the terminal block, perform the following steps,
while referring to Figures 1 and 2:

1. Unscrew the top cover screws and remove the top cover.

2. Configure each of the AC/DC coupling and ground-referencing
switches, depending on the signal you are measuring and the SCXI
module you are using. The top set of switches (S1, S2, and S3)
corresponds to input channel 0, the next set down (S4, S5, and S6)
corresponds to input channel 1, and so on. The bottom set of switches
(S22, S23, and S24) corresponds to input channel 7.

3. Ifusing the SCXI-1305 with an SCXI-1140 or SCXI-1141/1142/1143,
configure the SMB connector function (jumper W1).

4. Reinstall the top cover and tighten the top cover screws.

Connect the signal wires to the BNC and SMB connectors. When
connecting the signals to the SCXI-1305, follow the labeling on the
SCXI-1305 for the appropriate module.

Note Signal names printed in black (the first name in the pair) are for the SCXI-1120/D,
SCXI-1125,SCXI-1126, SCXI-1140, and SCXI-1141/1142/1143. Signal names printed in
blue (the second name in the pair) are for the SCXI-1121.

6. Attach the SCXI-1305 to the SCXI module using the thumbscrews.

7. Refer to the SCXI Quick Start Guide to power on the SCXI chassis and
configure the system in software.
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‘1 Rear Connector 2 Thumbscrew 3 Top Cover Screws 4 Top Cover

Figure 1. SCXI-1305 Parts Locator Diagram
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Channel 0 Switches
Channel 1 Switches
Channel 2 Switches
Channel 3 Switches
Channel 4 Switches
Channel 5 Switches
Channel 6 Switches

ONO O~ WN =

9 Channel 7 Switches
10 Serial Number

11 AC/DC Coupling Switches

12 Floating/Ground Reference Switches

13 SCXI-1121 Signal Connections

14 SCXI-1120/D, 1125, 1126, 1140,
1141/1142/1143 Signal Connections

15 SMB Connector
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Figure 2. SCXI-1305 Signal Connections
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Circuit Diagram

You do not need to read this section to operate the SCXI-1305. The circuit
diagram in Figure 3 is optional information that you can use if you want
more details about the SCXI-1305 circuitry. Figure 3 shows the circuitry
for one of the eight analog channels.

%— °¢
—O +
I o AC
1 R,
’ 1 MQ
10%, 10 ’
%o Module
Inputs
(),
pu 1%
%— be
| "
I }—L—o AC
(open) G :OFi/F
(closed) F 50V

?
i/
100 kQ,
5%

@ Ties to analog ground on the SCXI-1140 and SCXI-1141/1142/1143.
On the SCXI-1120/D, SCXI-1121, SCXI-1125, and SCXI-1126,
it is left floating.

Figure 3. SCXI-1305 Circuit Diagram

Specifications
All specifications are typical at 25 °C unless otherwise specified.
Electrical
Compatible modules
SCXI-1120/D ..o 8 input channels
SCXI-T121 e, 4 input channels,

4 excitation output channels!
SCXI-1125
SCXI-1126

8 input channels

8 input channels

! The excitation output channels must be configured for DC coupling.
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SCXI-1140..cccueiiiiiiiiiiiiiiiiieeieeiiias 8 input channels,
one external clock signal

SCXI-1141/1142/1143 .................... 8 input channels,
two clock signals

Coupling ...cceevveeveneesieneeiineeneeeeieneens DC or AC
(selectable on a per-channel
basis using slide switches)!

AC coupling circuitry
Corner frequency (-3 dB)................ 0.16 Hz
DC-rejection capacity ...........c..c....... +42 VDC
Input impedance (minimum)
Between CH+ and

CH- terminals .......ccocuvvvvvvvennnns 2 MQ
Between CH+ or CH-
terminal and ground ................ 1 MQ?

Maximum working voltage
(signal + common-mode)

Channel to ground ..........ccccceeenenee. Each channel must remain within
+42 VDC of ground
Channel to channel ..........c..coceunee. Each channel must remain within

+42 VDC of the voltage applied
to any other channel

Field-wiring connectors

Signal connectors.........ceccevvereeeeennen. 8 female BNC connectors
Auxiliary connectors ..........c.c....... 1 female SMB connector
Signal connector spacing................. 1.8 cm (0.75 in.)

Ground-referencing

You can configure the SCXI-1305 for use with either
ground-referenced or non-referenced (floating) signal sources on a
per-channel basis using slide switches. When a channel is configured
for use with a non-referenced (floating) signal source, CH— is
connected to analog ground through a 100 k€ resistor.

! In instrumentation terminology, DC coupling means that both DC and AC signals are passed. AC coupling means that
DC signals are blocked and AC signals are passed.

2 Does not apply to the SCXI-1120/D, SCXI-1121, SCXI-1125, or SCXI-1126.
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Mechanical

30.3 mm ! 99.3 mm '
: —— S —
,(11910n)) | (8.911in.) '
H N R
' Ao

=)

173.5 mm
(6.83in.)

(14.5 oz)
Environment
Operating temperature............cocceeueeueenee. 0to50°C
Storage temperature .........ceceervveeveeesneenns -20to 70 °C
Humidity ..oooevveniiniiiiniiiciiiciecs 10 to 90% RH, noncondensing
Maximum altitude...........ccooeevveeeeennnenn. 2,000 meters
Pollution Degree (indoor use only)........ 2
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Safety

This product is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

« IEC61010-1, EN-61010-1
« UL 61010-1, CSA 61010-1

@ Note For UL and other safety certifications, refer to the product label or visit ni . com/
certification, search by model number or product line, and click the appropriate link
in the Certification column.

CE Compliance

This product meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

*  2006/95/EC; Low-Voltage Directive (safety)

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit ni.com/
certification, search by model number or product line, and click the appropriate link
in the Certification column.

Environmental Management

SCXI-1305 Installation Guide

National Instruments is committed to designing and manufacturing
products in an environmentally responsible manner. NI recognizes that
eliminating certain hazardous substances from our products is beneficial
not only to the environment but also to NI customers.

For additional environmental information, refer to the NI and the
Environment Web page at ni.com/environment. This page contains the
environmental regulations and directives with which NI complies, as well
as other environmental information not included in this document.
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Waste Electrical and Electronic Equipment (WEEE)

EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling
center. For more information about WEEE recycling centers and National Instruments

WEEE initiatives, visit ni.com/environment /weee.htm.

1

BT ERFmITRESEENZE (PE ROHS)

MEZEF  National Instruments £F4 i L5 B il BRI 2847 S0 R 4 (ROHS).

KT National Instruments [ RoHS A #IPE(E &, %% ni. com/environment /rohs_china.
(For information about China RoHS compliance, go to ni . com/environment/rohs_china.)
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National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents . txt file on your media, or
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